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WORD 2016 LAYOUT  

Word 2016 is almost identical to Word 2013. It is made up of elements like the File Tab, Ribbon 
Bar and Quick Access Tab.  

1. The File Tab is used to access file management functions such as saving, opening, 
closing, printing, etc. ‘Options’ is also available here so that you can set your working 
preferences for the application.  

2. The Ribbon Bar is the tabbed band that appears across the top of the window. It is the 
control centre of all office 2016 applications. You can use the tabs on the Ribbon to 
access commands which have been categorised into groups, such as galleries of 
formatting options that you can select from, such as the Styles gallery shown here.  

 
3. The Quick Access Toolbar, also known as the QAT, is a 

small toolbar that appears at the top left-hand corner of the 
window. It is designed to provide access to the tools you use 
most frequently and includes, by default, the Save, Undo and 
Redo buttons. You can add buttons to the Quick Access Toolbar to make finding your 
favourite commands easier.  
 

4. The Status Bar appears across the bottom of the window and displays application 
information, e.g. page number, slide number, cell count, dictionary, and so on. It can 
also be customised to have more functions showing by right-clicking on the bar and 
choosing the options. The View buttons and the Zoom Slider are used to change the 
view or to increase/decrease the zoom ratio for your document.  

 
5. We suggest you turn on the Navigation Pane in the View tab on the Ribbon Bar so that 

you can easily see where you are working in your document. The Navigation Pane 
shows an outline of a document's headings (e.g heading 1 to 4). It allows you to move 
whole sections or even chapters around by clicking on them with the mouse and 
dragging them up and down in the pane; a great time saver, especially when you’re 
working with your supervisors. The Navigation Pane is only available in Normal, Draft 
and Outline view. You can display or hide the Pane as you need it. To open the Pane, 
select the View tab and tick the Navigation Pane button. To adjust the size of the 
pane, move your mouse to the right edge of the pane, when the pointer changes, click 
and drag to the left or right. If your headings are too long to fit into the Pane, just rest the 
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pointer on a heading to view its entire text. 

Customising the Quick Access Toolbar  

The Quick Access Toolbar can be customised by adding buttons or removing buttons. This is 
the only part of the office interface that you can modify – you can’t add buttons to the ribbon or 
command groups. There are two methods that can be used to customise the toolbar   
The Customise Quick Access Toolbar tool displays a list of commonly used commands that you 
can add to the toolbar. Click on the items that you want to add. The tick on the left of the word 
indicates what is active in the list.  

1. You can add any command you like to the toolbar by selecting More Commands to 
display the Options dialog box. From here you can choose commands or tabs to add to 
the toolbar. Once in the QAT Toolbar you can place the icons into an order that suits 
your work by highlighting the icon and using the arrows on the right side to move up or 
down. You can even shift the Quick Access Toolbar below the ribbon if this suits the way 
you work. 

2. By right clicking on a function (e,g, a page break), you can add it to the QAT. 
If at any time you find the Ribbon Bar intrusive while 
you are working with your text, you can simply hide 
the Ribbon Bar either temporarily or permanently. 
Click on any tab (e.g. View) then double click the same 
tab. This will hide the bar. To access it, just single click 
on a tab, select your function then single click the tab 
again. The bar will disappear. To reactivate it, double 
click on one of the tabs or select the options from the 
top right button. 
The rest of this session guides you through using the Ribbon Bar to set up a master document 
for your thesis in line with the Flinders University preferred thesis styles.  
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*Note:  
Thesis examination will be done via electronic copy of your thesis from 2016. The layout 
for this version of your thesis is the same as for your very final electronic submission 
version for the library: 2 cm margins all around, no mirror margins. 

Page layout for electronic submission 
Page layout refers to the overall layout and appearance of your document, such as how much 
text you will include on each page, the size of the paper on which you will print your document, 
and so on.   
The margin is the white space around the sides, top and bottom of a page. By default, Word 
sets this to 2.5 cm (or 1 inch) for each margin. You will change this to 2 cm margins all around. 

Setting custom margins for electronic submission 

Setting the page layout to enable double-sided printing of thesis documents. Word provides 
several preset margins you can choose from, but for thesis layout it is necessary to make your 
own ‘custom margins’. 

1. On the Ribbon bar click on Layout  

 
2. Click on the arrow on the right hand side of bottom area labelled ‘Page Setup’ to activate 

the full page set up menu. This gives you the option of creating your own page layout.  
* To access the built in page layout styles, click on Margins instead of the arrow. This 
takes you to the following menu where you can choose built in style ‘custom margins’.  

3. Clicking on custom margins gives you the same menu as clicking on the arrow (see 
below). 

 
a. click on margins  
b. set top, bottom, left and right margins to 2 cm each  
c. set gutter to 0 cm, and leave gutter position as ‘left’.  
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d. under ‘orientation’, select portrait (inserting landscape pages is explained later) 
e. next to multiple pages, click on the little v and select ‘normal’ 
f. next to apply to, click on the little v and select whole document if you have no 

section breaks in the document, or this section if there are section breaks (section 
breaks are explained at the end of these page layout instructions) 

4. Next, click on ‘Paper’  

 
a. under ‘Paper size’, select ‘A4’ or ‘custom’. Check that it is set to width 21 cm, 

height 29.7 cm. 
b. under ‘Paper source’, select ‘default tray’ for both ‘first page’ and ‘other pages’ 
c. under ‘Apply to’, select ‘whole document’ or ‘this section’ *see note for 3f above; 

the same applies here 
d. click on ‘Print options’, then under ‘printing options’ select ‘print drawings 

created in word’, ‘print background colours and images’ and ‘update fields’ 
e. Click OK. 

***While you are in this menu, it’s a good idea to click on Show all 
formatting marks in the list above Printing options. You will be able to 
clearly see paragraph markers, and page and section breaks so you can 
work better in the document 
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5. Next, click on ‘Layout’ 

a. under ‘Section start’,  
select ‘new page’ 

b. under ‘Headers and  
footers’, leave check boxes 
blank 

c. go to ‘from edge’, set header  
to 1.25 cm and set footer to 
1.25 cm  

d. under ‘Vertical alignment’, 
select ‘Top’ 

d. under ‘Apply to’, select ‘whole 
document’ or if you are working  
on a file that has more than one 
section, select ‘this section’ 
here. 

e. you do not need to set ‘line 
numbers’ or ‘borders’, as you 
will not need these in the main 
text. ***Note: Line numbers are 
useful if you have interview 
transcript files. To add line 
numbers, click on ‘line 
numbers’, tick line numbering, 
then select continuous. 

f. Click OK 
 

1.25 cm 

1.25 cm 



© Flinders University  Page 6 

Page layout for double-sided printing: Custom margins 
Follow steps 1-3b as for electronic submission. 

Then at 3c, set gutter to 0.5 cm, and leave gutter position as ‘left’.  

 

d. under ‘orientation’, select portrait (inserting landscape pages is explained later) 

e. next to multiple pages, click on the little v and select ‘mirror margins’ 

f. next to apply to, click on the little v and select whole document if you have no section 
 breaks in the document, or this section if there are section breaks (section breaks are 
 explained at the end of these page layout instructions) 

Follow steps 4-5b as for electronic layout. Then at 5c, go to ‘from edge’, set header to 1.27 cm 
(0.5 inches) and set footer to 1.27 cm (0.5 inches) (see next page) 

Then follow steps 5d to 5f as for electronic set up. 

 

***Note, if you want a printed hard bound copy of 
your thesis when it is finished, you would set the 
double sided layout to 2.5 cm margins all round, 
and set the gutter to 2 cm, position left. This will 
leave you a wide left margin so the writing does 
not get swallowed up by the hard binding. 
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Inserting page breaks and section breaks 
When a page fills with text Word will automatically roll over to the next page. A page break is 
simply a code that tells the computer to display and print the text that follows the code on the 
next page. Sometimes you may want to override Word and insert your own manual page 
breaks, for example to ensure an image plus the text that refers to it, remain together.     
Page breaks and section breaks are both accessed from the Layout tab on the Ribbon Bar. 

1.  For page breaks, place the cursor at the end of the text before you want to insert the 
page break, then click on Page. 

 
For section breaks, place cursor at the end of the text before you need the section break and 
click next page. Section breaks are used at the end of chapters or other parts of the document 
that require individual formatting. Section breaks also allow you to put different text and different 
types of page numbering in the headers and footers for different sections (e.g. Chapter 1, 
Chapter 2 etc). **If you select odd page or even page, you will get blank pages between sections, 

Inserting a landscape page 
 

If you need a landscape layout for pages within a chapter/file, for example to accommodate a 
large table or diagram, use section breaks to ‘section’ these pages off from the rest of the 
chapter.  

1. If possible, hit enter at least once at the end of what will be the last line of text on 
the page where you are inserting the section break, then click Next page in the 

1 

2 
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Breaks menu.  
2. The cursor will jump down to the next page. Hit enter several times then click Next 

page again. 
3. Place cursor in the blank page created by inserting two section breaks.  
4. On the Ribbon Bar, click on Layout, then click the triangle beneath Orientation. 
5. Select Landscape. 

 
 
 

Removing page breaks and section breaks 

If you significantly alter a document in which you had previously inserted manual page breaks 
and/or section breaks, you will need to recheck the pagination once you have finished your 
changes to ensure that the breaks still occur at the required locations. If the pagination is not 
correct, you can simply delete the unwanted page breaks or section breaks by clicking on them 
to highlight and pressing delete. 

An issue to be aware of with double-sided documents if you are going 
to save them as pdf.  
If you have large tables or other illustrations that are on landscape pages, you need to be aware 
that you need to turn them upside down because when converting to pdf, it turns them around.  
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Headers, footers and page numbers  
Header is text you wish to see at the top of every page. Footer is text you wish to see at the 
bottom of every page. The steps below explain how to add a simple header or footer to your 
document.   
***Normally in a thesis, there is no text in the header. Text and page numbers generally 
go in the footer,*** 

1. On the Insert tab, in the Header & Footer group, click Header, Footer or Page Number.  
 
2. Click the design that you 
want from the options.  
3. The header or footer is 
inserted on every page of the 
document. You will also see 
the body text is now lighter. 
 4. You can now add/modify 
the text, format the text or 
change the position.   
5. You will also notice the 
Ribbon bar has popped up 
header and footer, tools 
Design tab 

 
 
6. Click on the header 
and footer tools Design tab to 
activate working in headers 
and footers 
You now have options that 
can be applied to the Header 
& Footer bars.     
You can control where in the 
header or footer your text and 
/or page numbers appear – 

left, centre or right. 
 

 

Inserting page numbers in footers 

1. In the header and footer design tab, select page number. 
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a. click on Bottom of page and select Plain number 2 (centred page number).  

 
b. This will take you back into the Design menu 

c. You will notice in this menu whether Link to 
Previous is highlighted. Click on this to turn it 
off. This controls text and page numbers 
following through from section to section 
d. Click on Page number again and this time 
select Format page number. 
e. Select the type of numbers you need. 
Select small Roman numerals (I, ii, iii etc) for 

all pages from Contents to Chapter 1. Start the Arabic numerals (1,2,3 etc) from 
the first page of chapter 1. The title page has no page number. **In double-sided 
printing, you will need to turn off same as previous on the first odd and the 
first even page of each new section**  

f. If you want page numbers to continue from the previous section/chapter, check 
‘continue from previous section’ 

g. If you want to start fresh numbering in the section or chapter, select ‘start at’ and 
enter the starting number (usually 1). 
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***Sections in the ‘Preliminaries’ file will have small 
Roman numerals for page numbering, while the rest 
of the document will have Arabic numerals. This is 
one of the reasons why it is important to keep the 
‘same as previous’ option turned off. If it is on, all 
numbers or text in the header or footer will be the 
same throughout the entire document - so will all 
text in headers or footers (you might get 400 pages 
with a footer saying Chapter 1!) 
***When working in headers and footers, you 
must have the cursor blinking in the header or 
footer space on the page, otherwise nothing will 
happen. When you click into the header or footer 
space, the Design menu will appear, which 
includes the header and footer sub-menu.*** 
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Text layout – using styles 
The easiest way to set your text layout is by using ‘styles’. It is important to set your styles for a 
consistent appearance. This is particularly important in the case of ‘normal’ style, the ‘default’ 
style that pops up when you begin typing in any word document. ‘Normal’ default may differ 
from computer to computer, so you may need to modify it to meet thesis specifications.  
Heading styles also enable you to create an automatic table of contents and lists of tables, 
figures, diagrams etc. While it takes time initially to set your styles for your thesis, it saves time 
in the long term. You can set your own styles for things such as block quotes, bulleted lists, 
transcript excerpts, table of contents etc. If you are happy with the heading styles inbuilt in your 
computer, and they meet the thesis specifications, you can use these but will still need to set up 
a document as a styles template to ensure consistency in all files. 
A quick way to set a consistent set of major (headings) and body text (main text) styles is to use 
the change styles menu. 

Fonts 

Fonts required for a Thesis are to be Sans-Serif type. These are fonts without curls or flicks. A 
lot of fonts will display in different sizes based on the font selected. The most common fonts and 
recommended sizes are: 
Arial - minimum 11 

Calibri - minimum 12 

Tahoma - minimum 11 
Verdana - minimum 11) 
The remainder of the document is based on Arial as the font. 
 

Changing whole document styles 
1. On the Ribbon bar click on ‘Design’ 

 

 
 

a. From the Formatting ribbon select 'Black and white (Classic)' 
b. Next click on ‘Fonts’ then select ‘Arial’ or your desired 

font from those listed above. 
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How to set your text layout 

1. On the Ribbon bar click on ‘Home’ 
2. Look along the quick styles menu and select Normal 

 

 
 

 
3. Right click in Normal. This will give you the Modify tab, 

 
4. Left click on Modify to get the Modify styles menu. 
 
 
 
 
 
 
5. Make sure style for following paragraph says 
Normal. 
6. In quick Formatting, make sure the font is showing 

Arial size 11, or whichever of the styles you chose from those listed earlier. 
7. Next make sure B, I and U are not shaded. 
8. Select left hand alignment. 
9. Select 1.5 line spacing. 
10. Select Automatic for font colour 

 
 

11. Next Click on ‘Format’, then ‘Paragraph (see picture next page) 

 

1 

2 

6 

8 9 

7 10 
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12. Select ‘Indents and Spacing’ 
13. Under ‘Alignment’, select ‘Left’ (***or ‘Justified’ if this is specified in your instructions***) 
14. Under ‘Indentation’, select 0 for both left and right  
15. Under ‘Spacing’ select 0 for ‘Before’ and 12 for ‘After’ 
16. Under ‘Line spacing’ select 1.5 lines. Leave the ‘At’ box blank 
17. Under ‘Special’ select ‘(none)’  

if instructed to use indenting APA style you would select ‘First line’ under Special, 
then type in 1.27 cm (or 0.5”) under ‘By’. Also, in spacing after, select 0 pt. See p. 
27*** 

18. ‘Outline level’ – make sure it is set on ‘body text’ 
19. Make sure ‘Don’t add space between paragraphs of the same kind’ is NOT CHECKED 

 
20. Now click on line and page breaks 
21. Place only one tick in Don’t hyphenate. Make sure all other boxes are blank. 
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22. Finally, select Tabs. Set tabs at 1.27 cm, left aligned, with None in leader 

 
23. Click OK. This takes you back to the Modify styles menu. 
24. Next, select Format again. Scroll down to select Language. 
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25. Select English Australia unless you have 
instructions to choose another language (maybe 
English UK or English US). It is very important to 
use consistent language throughout. ***Make 
sure you do not tick ‘Do not check spelling 
and grammar’. You need to have this checking 
done, but beware it is not always correct. Use 
your brains – do not blindly accept the computer’s 
suggestions.*** 

26. Click OK. This will take you back to the modify 
styles menu. 

27. Click format again and select Frames. 
 

Click remove frame. 
28. This takes you straight back to the Modify styles 

menu. 
29. Now put a tick in add to styles gallery and new 

documents based on this template. 
30. Click OK.  
31. Normal style will be the basis for all other styles in the document. 

 
***It may be wise to quickly check the other options in the format menu – borders, numbering, 
text effects in case there is some oddity. These should all be set to none as a default. There is 
no need to check Tabs because you have already set these in the Paragraph menu.*** 
The reviewing pane (blue arrow) lets you see exactly what the style is. You can check this and if 
it is not right, you can modify the style again. 
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Setting APA Normal style indents and spacing as illustrated. 

 
 

Heading styles 
Try not to have only three heading levels in the text. Designate chapter headings as Heading 1, 
then in-text Heading 2, Heading 3, Heading 4. Use the ‘caption’ heading installed in your 
computer for Table and Figure headings. Each Heading style should represent its level, e.g. 

HEADING 1 – CHAPTER HEADING 

Heading 2 – major in-text heading 

Heading 3 – in text sub-heading 1 

Heading 4 – in-text sub-heading 2 
 
In setting all your heading styles, follow the same process as for setting Normal. Begin by 
selecting Heading 1 from the quick styles list in the Ribbon bar.: 
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1. Right click on heading one, left click on modify.  

 
 

2. This gives you the modify style 
menu. 
3. Make sure ‘style based on’ says 
Normal, and ‘style for following 
paragraph says Normal’. 
4. Check quick Formatting menu. Font 
is Arial headings, as set. Check the 
font size. If it is not 16, click on the v 
and select 16. 
 
5. Click on the B for bold (all headings 
should be bold). Make sure the I 
(italics) and U are not shaded. Text 

colour automatic already set from Normal.  
6. In the next row down, select centred for alignment and single line spacing (both shaded). 
7. Now go into the Format menu, and go into font 
8. In the Effects menu, place a tick in All Caps to make the heading all capitals. ***You do 

not have to have all capitals. Heading 1 can be ‘Small caps’ or just as it is – no need to 
tick any boxes.*** 

9. Click OK. This takes you back to the Modify styles menu. 
10. Click on Format again and select Paragraph. 
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11. Check that alignment is Centred, 
outline level is 1, there is 0 indentation, 
and none under Special. 
12. Under Spacing, put 0 pt before and 
24 pt after. 
13. Make line spacing Single. 
14. Place a tick in Don’t add space 
between paragraphs of same style. 
15. Now click on Line and page breaks 
16. Leave this set as it is for Normal – 
no ticks anywhere except for Don’t 
hyphenate. 
17. Click OK. 
 
 
 
 
18. No need to check other options 
under Format because this was done in 
Normal, and Heading 1 is based on that 
style. BUT YOU MUST CLICK ON 
FRAMES AND REMOVE FRAME every 
time. 
19. This takes you back to the Modify 
styles menu again. 
20. Place a tick in add to styles gallery 

and new documents based on this template, just as you did for Normal style. 
21. Click OK. Heading 1 is done. 

Heading 2 
Follow the same process as for Heading 1, but begin by clicking on Heading 2 in the Quick 
Styles list, then ‘modify style’ with the following variations:  

22.  ‘Font’ size will be 14. 
23. In the Font menu under Format, make sure there are no ticks in any of the boxes under 

Effects. 
24. In the Paragraph menu under Format, Indents and spacing, select left for alignment, and 

15 pt before and 12 pt after for spacing. 
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. 
25. The major change is in the Line and Page Breaks  

menu. To stop a Heading 2 being stranded at the  
bottom of a page and its following text being on the  
next page, you need to put ticks in Widow/orphan  
control, Keep lines together and keep with next, as  
well as the Don’t hyphenate 

Make sure to go into Format, Frames and REMOVE FRAME. 
Then, on the Modify Styles menu, make sure to tick ‘Add to style list’ and ‘New documents 
based on this template’. Then OK. 

Heading 3 

Steps for modifying Heading 3 are the same as for Heading 2, except you start with Heading 3 
on the quick styles ribbon, select size 12 in the quick formatting line of the modify style main 
menu, and in Format Paragraph, Indents and spacing, select 12 pt before and 9 pt after. All 
ticks in the Line and page breaks menu are the same as for Heading 2. Remember to REMOVE 
FRAME and tick add to style list’ and ‘New documents based on this template’. 
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Heading 4 
Follow the same process as for Headings 2 and 3, but begin by clicking on Heading 4 in the 
quick styles ribbon. In modify style, formatting line, make sure font size is 11, and click on the I 
for italics. The B should already be highlighted. Go into Format, Font, and make sure no Effects 
are ticked.  
Click on ‘Format’, then ‘Paragraph’, and in indents and spacing, select left alignment, and 9 pt 
spacing before, 6 pt spacing after 
All other steps in the ‘Paragraph’ menu are the same as for Heading 3, except ‘Outline level’ is 
set at 4. 
Again, make sure to go into Format, Frames, 
and REMOVE FRAME. Then go back to the 
main modify styles menu and tick ‘Add to style 
list’ and ‘New documents based on this 
template’. Click ‘OK’ 
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Numbered headings 
Some disciplines require theses to be written in report style, APA, which involves a system of 
numbered headings. This requires some variations in formatting for Heading 1 style. Once that 
is set, numbering for all other levels of heading will follow automatically. 

1. Click on Heading 1 in the quick styles on the Ribbon Bar (Home tab). 
2. Select Multi-level list in the Paragraph group (blue). 
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3. Click on the option shown that has 1  Heading 1, 
1.1 Heading 2  etc,  
4. You will see in the quick styles ribbon how the 
appearance of all the heading styles reverts to 
numbering when you set this for Heading 1 
5. If you want to change the look of the numbered 
heading style, you can select Define new Multilevel 
List from the Multilevel List menu and change its 
appearance (see next page). Click on font to change 
number font; click on number style to change the look. 
6. Set the multilevel list for Heading 1 and all other 
headings will follow. 
 
 
 

 
 
 
 
 
 
 
 
 
 
***NOTE: If you use numbered 

headings you will need to create a separate Heading 1 equivalent style for preliminary headings 
such as Summary, Declaration etc and at the end for Appendices because these are not to be 
numbered.  
 

Table/figure/diagram headings – caption 
Insert captions for tables, figures etc. by right clicking with the mouse on the corner of a table or 
on text boxes, images etc  
When the menu appears, click on Insert caption (see next page). 
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The Caption menu appears 

   
 

Select the label you need. If the label you need is not there, you can click on New Label and 
type in what you need. 
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If you are using numbered headings, select include 
chapter number in the caption menu. Always start 
with Heading 1. The separator can be a colon, 
comma, dash - something to separate the chapter 
number from the table or figure number. Have a 
look at the previews in the Caption menu to decide 
what you want.  
You can modify the ‘caption’ style so that it is 
similar to Heading 3 in appearance, but one font 
size smaller (font size 10). It may already be set as 
this, or it may be one size smaller again (size 10). If 
you are happy with the default setting for ‘caption’, 
just use it as it is. ***Caption may not appear in the 
styles list unless you actually insert a caption. It is 
then possible to modify the style using the same 
processes as for modifying other styles. It is 
important that in Format, Paragraph, Indents and 
Spacing, select 6 pt before and 6 pt after as Caption spacing, and single line spacing. 
Examples of captions. 
Table 1: Percentage of bacteria that survived the experiment 

Dead % Live % 
95 5 
  
  
  
  
  
  
  
  

 

 
Figure 1: Stretched 
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Styles for special text, eg block quotes/transcript text 
If you are using long quotes from other sources (eg authors), it is standard practice to ‘block’ 
these if they are 40 words or more. Setting a style for this makes it quick to ensure consistency 
throughout your text. Block quotes are generally single-line spaced and one size smaller than 
normal font. Click on the arrow at the bottom right hand end of the styles ribbon to see all the 
styles. Select Intense quote.  

 
Right click in Intense quote. 
Left click on modify.  
Make sure the style is based on Normal. This sets the font. 
In the quick formatting part of the modify styles menu, change the font size to 10, line spacing 
single. 
Go to Format, Paragraph and in Indents and Spacing, indent 1.27 cm left and right. Set spacing 
to 0 pt before and 12 pt after, and no tick in Don’t add space between paragraphs of the same 
style. 
Line and page break settings will be as for normal; only one tick in Don’t hyphenate. 
Remember, go to Format, Frames and REMOVE FRAME, Remember to tick add to styles and 
Documents based on this template. 

 
The following example is what the block quote looks like: 
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Intense Quote of 40 words or more from other sources so that this really stands out from 
the text and doesn’t just disappear 

Having set the style for block quotes from literature, other studies etc, a style for interview 
transcripts is needed. The transcript style (Quote) is based on the modified Intense quote. 
Everything is the same except for clicking the I for italics in the quick formatting line in Modify 
styles. 

Quote based on intense quote but modified to be italics instead of regular for transcripts 

 

TABLES OF CONTENTS 
Inserting a table of contents and list of tables and figures/illustrations or whatever you need to 
list is a valuable tool, not only when the very final version of a document is ready, but during 
consultation with others and the many changes that occur over time. Inserting a Table of 
Contents at the beginning of each chapter if these are being done separately provides a map to 
what is in the chapter – it is a useful organising tool.  
To insert a Table of Contents, place your cursor on the first page after the title page, then on the 
Ribbon Bar click on References. 

 
Click on Table of Contents then select the style you want from the inbuilt list or choose ‘Custom 
Table of Contents’. 
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Select Custom Table of Contents. The following menu appears. 
Tick show page numbers, tick right align page numbers, but do not tick hyperlinks instead of 
page number (***you will use this option when you submit your electronic version of your thesis 
to the library after examination and correction). 
Under general, select Formal for formats and 3 levels of heading. 

 
Next, click on Option and the following menu appears. Tick styles and outline levels (this is 
particularly useful if you have had to create preliminary and Appendix headings without 
numbering if using the numbered heading system for the main text). 

 
Select the headings you need and click OK. This returns you to the previous menu. 
Click OK in this one also. Magically, your Table of Contents appears – a result of all your hard 
work creating styles! 
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Inserting a Table of figures  
Insert a page break after the end of the Table of Contents and insert your List of Tables and List 
of Figures on the next page.  
Click the References tab on the Ribbon Bar again and look in the Captions sub-menu to find 
‘Insert table of figures’. Click on this. 

 
Change the Caption label to the one 
you want. Eg. Figure or Tables. 
Make sure the ticks are in the 
following: 

• show page numbers 
• right align page numbers 
• Include label and number 
• Use hyperlinks 
Click OK 
List of Figures will appear where you 
had the cursor. Place a title above 
the list. Eg. List of Figures. 
Move a few lines down and repeat 
the process for List of Tables. 
Check that the Tables of contents, 
figures etc. have the correct page 
numbers by holding down control 

and clicking on them. This is also a good way to do a final check that your sequence of page 
numbers is correct and headings are correct (no spelling mistakes, odd spacing etc.).  

Saving the document as a template 
Click the File Tab then Save As. Select 'Browse'. 
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In ‘Save as type’ dropdown list select ‘Word Template’, and give the file a name. Save it to a 
folder. This can be your Master Document. 
For example: 

 
To open the template, go to where you saved it and click on it. Once opened, when you go to 
save, it will prompt you to Save as a new document. This will now be saved as a normal file (eg 
Chapter 1.docx). 
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MASTER DOCUMENT   

What Is a Master Document?  

A master document is a container for pointers to individual documents called subdocuments. 
Within the master document, the subdocuments appear to be one long document; but in reality, 
they are individual documents. A master document helps you to organise and to maintain the 
multiple subdocuments as a long document. Using a master document, you can work either with 
the entire long document or with any individual subdocument. Any Word document can be a 
master document or a subdocument (or both!). You can work individually in a master document 
(a long document) that you create yourself, or you can work with others within a workgroup to 
create and to revise subdocuments of the master document at the same time. 

 Advantages of Using Master Documents   

Working with a master document instead of individual Word documents makes it easier to: 
• Move quickly to a location within multiple documents.  
• See the latest changes to multiple documents without having to open a series of 

individual files. 
• Reorganise multiple documents simply by reorganizing headings.  
• Create different arrangements of subdocuments; for example, sorted by author or 

by chapter. 
• Create cross-references among multiple documents.  
• Compile indexes, tables of contents, and similar lists for multiple documents.  
• Print multiple documents without having to open a series of individual files. 
• Do all of the editing in subdocuments, outside of the master document, so that 

the entire master document does not have to be open, thus saving computer 
memory resources. This also allows multiple users to work on different parts of 
the master document at the same time.  

A master document handles the organisational details for you. You don’t have to assemble files 
or keep track of the file name or location of each subdocument to create a long document. For 
example, in a workgroup, individuals can access and work on any subdocument (individual 
document) by opening the master document.  

Creating a Master Document  

 Set Up    
You can set up a master document by doing any of the following:   
• Creating a new master document “from scratch” when you begin a long document.  
• Converting an existing document into a master document.  
• Combining existing documents to create a new master document.  
Whatever method you use, you work in Outline view to create, add, and arrange subdocuments. 
Outline view displays the Outlining toolbar so that you can create, promote, and demote 
headings; expand and collapse body text; and work with subdocuments.  
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The maximum number of subdocuments allowed in a master document depends on: the 
number of files you have open; the size of the files you have open; the number of programs you 
are running; the amount of computer memory; the operating system you are using; and other 
system configurations. If you reach this limit when you save the master document, Word can’t 
save your documents. To work around this problem, you can do one of the following:  
• Cancel saving the master document, close other programs or other documents, and then try 
saving again. 
 • Convert some of the subdocuments into master document text, and then save the master 
document. 
 • Remove the subdocuments from the master document, and then save the master document. 
You can then print the subdocuments individually or copy the text from the subdocuments into a 
regular Word document.  

The Importance of Heading Styles in Subdocuments  

To create tables of content, Word looks for the built-in heading styles (Heading 1 to Heading 9). 
Use these built-in styles to format headings as you set up a master document.  
 

As you organise the headings, decide which heading level will mark the beginning of each 
subdocument. For example, you might want to use a Heading 1 for the title of each 
subdocument and then use a Heading 2 for the next main level. The important part is to keep it 
consistent in all subdocuments. 

Creating a Master Document by Inserting Existing Word Documents  

1. Create a new document  
2. Select the View tab    

 
3. Click on the Outline button. A new tab appears called Outline. Click on the Show Document 
button. This will now give you the insert options.     

 
4. Place the insertion point where you want to add the subdocument. Make sure that Show/Hide 
is turned on so that you can confirm that your insertion point is not contained within a 
subdocument. If it is in a subdocument, the result of the insertion will be a sub-subdocument!  

5. Click Insert on the Outlining ribbon bar. This gives you a window with all the 
documents available.  
6. In the new window select the document you want to add, and click Open. Word adds the 
document and keeps its original file name.  
7. If Word finds duplicate styles it will ask you if you want to rename it. Select No to All as you 
only want one version of each style.     
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8. Repeat steps 2 to 4 to insert further subdocuments.  

Note: If the new document and the master document are based on different templates, or if they 
have different settings, Word will use the formatting from the template attached to the master 
document when you view the subdocument from within the master document. However, if you 
open the subdocument (from either within or outside the master document) Word uses the 
formatting of the template attached to the subdocument.  

Working With a Master Document Using Views  

You can work with a master document in any view (Outline, Print Layout, Draft…). 
 • Switch to Outline view to see or revise the structure of a long document or to open specific 
subdocuments.  In Outline view, you see an outline of the entire document and can easily open 
any subdocument. 
 • Switch to Print Layout view to work on the master document as a whole. With the master 
document open in Print Layout view, you can create cross-references among multiple 
subdocuments and make other changes easily, just as if you had opened a single long 
document. When you work in Print Layout view, each subdocument will be contained between 
section breaks of the master document.  This view allows more control to determine which 
section you are in and what properties apply to the section.   

Subdocument Hyperlinks  

When you first open a master document, all subdocuments will be collapsed; that is, each 
subdocument will appear as a hyperlink showing only the path and file name of the 
subdocuments. For example:     

 
By clicking on the hyperlink you can open the subdocument in its own window and then edit the 
document.   
If you prefer to work on the master document as a whole, you can expand the subdocuments by 
clicking Expand Subdocument on the Outlining ribbon bar and work on the whole document.  
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Making Changes to the Master Document and Subdocuments   

After you set up a master document, it is important that when you make changes that affect the 
overall document, you do so from within the master document. For example, if you need to add, 
remove, rename or change locations of a subdocument from a master document, make sure 
that you open the appropriate master document and then make the changes from within the 
master document.  
Do not use File Manager or Windows Explorer to delete files that are part of a master document 
unless you first remove the subdocument from the master document.  
Renaming or changing the location of a subdocument  
1. Display the master document in Outline view  
2. Open the subdocument you want to change.  
3. Choose File | Save as…  
4. Specify a new file name or location (or both) for the subdocument, and then click Save  
5. Choose File | Close to return to the master document.  

Splitting a subdocument into two subdocuments  

1. In Outline view, select the heading or place the cursor (insertion point) where you want to 
split the subdocument  

2. On the Outlining toolbar, click Split.   
3. To save the changes in both the master and the subdocuments, choose File | Save. Word will 
save the new subdocument using the first sentence of the new document.  

Merging subdocuments:  

To merge subdocuments, they need to be after one another in the master document.  

1. Click the subdocument icon of the first subdocument that you want to merge  
2. hold down Shift and click the subdocument icon of the last required subdocument 

3. On the Outlining toolbar, click Merge Subdocument   

Notes: All section breaks will be retained so you may want to delete some. When you save the 
master document, Word saves the merged subdocuments using the file name of the first of 
those subdocuments. If you no longer need the previous (original) version of a subdocument, 
you may now safely delete it in the usual manner.  

Converting a subdocument into part of the master document:   

1. In Outline view, click the subdocument icon to select the subdocument that you want to 
convert into the master document text 

 2. On the Outlining toolbar, click the Unlink button.    
Word will convert the subdocument text into part of the master document retaining all 
associated section breaks.  



© Flinders University  Page 35 

Deleting a Subdocument and Its Contents from a Master Document   

To remove the contents of a subdocument from a master document, switch to Outline view, and 
then delete the subdocument. Do not just delete a subdocument from the disk; if you do, you’ll 
get an error message the next time you open the master document.  
1. In Outline view, click the subdocument icon to select the subdocument that you want to 
delete  
2. Press the Delete key on the keyboard Word removes the subdocument from the master 
document but retains all associated section breaks.  

Note: When you delete the subdocument from the master document, the subdocument still 
exists on the drive and in the folder where it was stored.  You may now delete the file from its 
folder using any usual method if you no longer need it.    
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USING ENDNOTE TO CREATE REFERENCE LIBRARIES  
If you are using Endnote, you must ensure that you enter all reference details correctly, and when 
importing citations directly from electronic libraries, do a quick check to make sure they have worded 
properly.  
WARNING: Do not think that Endnote will somehow magically put in the references for you correctly if 
you have not entered them correctly. All necessary information must be added, it must be correct and it 
must be entered into the relevant ‘fields’.  
If you are away from your computer when you find useful references, write them down in full in your thesis 
notebook, then enter them into Endnote as soon as possible. Wherever possible, enter references directly 
into Endnote.  
If you are not using Endnote currently or use it but do not really understand it, please enrol in an 
ENDNOTE WORKSHOP – it will make your life so much easier! 

TIPS  
1. Follow instructions – set up documents according to these given guidelines (layout, 

referencing style, word count etc.)  
2. Carry pens, pencils, a ‘thesis notebook’ and a hard drive or cloud storage for backing up 

your work everywhere you go  
3. Take time to do things properly as you go along – there may not be time to fix them at 

the end  
4. Do not put all your faith in computers - write down everything in the notebook – 

document set-up, styles, all references, thoughts, discussion notes around references  
5. Enter all references carefully and correctly into an endnote library – make sure you have 

a back-up  
6. Make sure ‘same as previous’ is NEVER on in headers or footers  
7. Keep relevant style guides with you at all times  
8. Seek help when you need it – don’t let queries hang around  
9. Be consistent with everything – styles, language, spelling, layout, in-text citations and 

bibliographic citations.  
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